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Introduction
Welcome to the world of multimedia video. Your new ATI mach32 graphics card is multimedia 
ready!

With the simple addition of ATI mach32 multimedia video drivers, your GRAPHICS ULTRA PRO 
or GRAPHICS ULTRA+ accelerate the new generation of video applications. The video drivers 
included in this package will enable you to playback video at a larger, more usable size while 
maintaining smooth motion and audio synchronization.

ATI is making video an integral part of all of its graphics solutions. We are dedicated to ensuring 
that users will realize the greatest potential from their Windows-based video applications without 
the need to buy additional expensive hardware. We are also dedicated to ensuring that your new 
purchase will not become obsolete when the new wave of video-based applications becomes 
available. This is just one more way that ATI is Perfecting the PCTM.

Desktop Video
Video is a powerful medium, since a great deal of information can be conveyed in a very short 
time. This is one reason why television has proven to be so popular. Combining video with the 
personal computer results in additional power since the PC adds the capability of interacting with 
and modifying video in meaningful ways. Desktop video is therefore an ideal vehicle for training, 
entertainment, communications and many other applications.

But video is also a data-intensive medium. A 30-second video clip captured at 160x120 resolution
can be as large as 20MB. This much data can be difficult for the PC to display and store, since 
the amount of data to be handled exceeds the capabilities of CD-ROM's and the PC's data bus 
architecture. These problems increase the need for data compression and acceleration. In the 
past, there was no video standard to encourage solutions to these issues. This prevented the 
widespread use of video on the desktop.

Video for Windows
Recent events have dramatically improved the ability of video to become usable on standard 
PCs. The first of these developments is Microsoft Video for Windows (VFW). VFW allows users to
capture, edit and playback video on their PCs. Perhaps more importantly, it provides a standard 



platform for developers to write applications which incorporate video, thereby bringing video into 
the mainstream. This will result in many new and exciting video-based applications.
Compression VFW includes three standard ways of compressing video data: RLE, Video 1 and 
Intel's Indeo video. 

Indeo video is particularly useful as a compression method since it allows users to capture video 
in real-time (30 frames per second) with additional hardware. Other compression methods do not 
have widespread availability of real-time capture hardware. In addition, Indeo video captures 
video at a full 24-bit color depth, resulting in more life-like images. Other compression methods 
are limited to 8- or 16-bit color.

ATI Accelerated Video
Another significant video development is ATI's support of multimedia video acceleration. ATI's 
mach32-based accelerator products have the ability to playback video at a much faster rate than 
competitive products. This enables you to enlarge the standard VFW "postage stamp" 160x120 
image to a more usable size while maintaining full frame rates and audio synchronization. All 
mach32 products accelerate the playback of applications based on RLE, Video 1 and Indeo video
compression methods, making them full-function accelerators for VFW-based video applications.

What's in the Package
The ATI mach32 accelerator cards come with the following software and video drivers:

All of the drivers required to accelerate Indeo video, RLE and Video 1 files under Video 
for Windows in 16 bpp color mode.

Sample Video for Windows clip
Microsoft Windows Media Player for Video for Windows - a multimedia playback 

application for the Audio/Video Interleaved (AVI) file format.

What You'll Need
Microsoft Windows version 3.1
Sound Card (to take advantage of the sound capabilities of VFW)
In addition to the above, Microsoft recommends the following playback system 

requirements for Video for Windows:
- 386sx/16 or higher
- VGA display (256-color or greater)
- Options: A CD-ROM drive for playback of the Video Clip

Library
   A large hard disk recommended for storing
 digital video

ATI GRAPHICS ULTRA PRO or GRAPHICS ULTRA+

Video playback performance is affected significantly by CPU, RAM, video adapter memory and 
bus architecture (refer to the section on Performance for more information). Improvements in any 
of these elements will result in improved video playback. 

While Microsoft has cited the above as minimum system requirements, it is our opinion that a 
386/33 system is the minimum for acceptable playback. We suggest a 486-based system for 
maximum flexibility of video playback.

Installing Windows 3.1 with Multimedia Video Drivers
This section provides the procedure for copying Windows drivers and multimedia video drivers to 
your hard disk. The new video drivers only work with Windows 3.1. Have your application 
diskettes and ATI mach32 accelerator diskettes handy before you start. You may require the 
application reference manual for instructions to configure the newly installed driver to work with 
your application.



1. Type install at the C:\MACH32 prompt and press <enter> if you have already installed 
the software utilities or follow the instructions in Chapter 2 to load the Main Selection 
Menu.

2. From the Main Selection Menu, choose Install Device Drivers and press <enter>.

3. Your screen now displays the Install Device Drivers Menu. Choose Microsoft Windows 
and press <enter>. 

4. Follow the instructions on the screen to complete the installation of the driver.

5. Press <esc> to exit or select another function from the Main Selection Menu.

6. You must configure Windows to use the newly installed driver. You can configure 
Windows from the DOS command line using the SETUP program when in the Windows 
directory. 

At C:\WINDOWS type setup and press <enter>. 
Select Display and then ATI mach32 Driver. Save your selection. Start Windows.

Configuring your Multimedia Video Display
When you start Windows, the Program Manager opens, displaying a README icon and 

an ATI FlexDesk icon in the mach32 utilities program group. Select the ATI FlexDesk Control 
Panel icon to configure your Windows and multimedia video display. 

The ATI FlexDesk Control Panel opens. Select the Video push-button to open the Video Display 
Control panel if you want to adjust the multimedia video display parameters. 

For instructions on configuring your Windows display, refer to Configuring your Windows Display 
in Chapter 3.

Video Display Control Panel
Use this panel to adjust the video display window by specifying:

Brightness
Contrast
Saturation
Hue

Changing these four parameters changes the display of the video window. As you change the 
settings, the Gray Scale and Color bars change concurrently to reflect the new settings. 

Brightness Moving the slider to the left decreases the brightness. Moving the slider to the 
right increases the brightness.

Contrast Moving the slider to the left decreases the contrast. Moving the slider to the right 
increases the contrast.

Saturation Moving the slider to the left decreases the amount and strength of color. Moving 
the slider to the right increases the amount and strength of color.

Hue Moving the slider to the left increases the amount of red and decreases the 
amount of green displayed. Moving the slider to the right increases the 

amount of green and decreases the amount of red displayed.



Optimal Settings

640x480 800x600 1024x768 1280x1024

4 bpp Unaccelerated Unaccelerated Unaccelerated Unaccelerated
Playback Playback Playback Playback

8 bpp Unaccelerated Unaccelerated Unaccelerated Unaccelerated
Palette Mgr. On Playback Playback Playback Playback

8 bpp * GUPRO GUPRO GUPRO Unaccelerated
Palette Mgr. Off 1MB/2MB 1MB/2MB 1MB/2MB Playback

GU+ GU+ 
1MB/2MB 1MB/2MB

16 bpp GUPRO GUPRO GUPRO Unaccelerated
Recommended 1MB/2MB 2MB 2MB Playback

GU+
1MB/2MB

24 bpp Unaccelerated Unaccelerated Unaccelerated Unaccelerated
Playback Playback Playback Playback

GUPRO = GRAPHICS ULTRA PRO   GU+ = GRAPHICS ULTRA+
* Users may experience color degradation in Palette Manager Off mode. 16 bpp color mode 

is strongly recommended.

For optimal performance of video clips, the following settings are suggested for the ATI FlexDesk 
parameters: 

Resolution - 640 x 480
Colors - 65,000 (16-bit)
Desktop - No effect
16 Bpp RGB Mode - 5/6/5
256 Color Palette - OFF (if using 256 color mode)
CRYSTAL Fonts - OFF

Playing Video Clips
Microsoft Windows Media Player for VFW is provided for playing video clips and for inserting 
them into various documents. For detailed description and instructions on using the Media Player,
please refer to the Media Player on-line help and the Microsoft Windows 3.1 User's Guide.

Using Media Player
To start Media Player, start Windows and choose the Media Player icon in the Program Manager. 
The Media Player is displayed.

To Select a Device
Open the Device menu and choose Video for  Windows ... . You only need to choose this once, 
unless you change the setting to another device (e.g. MIDI Sequencer...).

To Open a File
Open the File menu and choose Open. The Open dialog box is displayed. Specify the directory 
and enter the name of the file you want to open or select the file using the mouse. Choose OK. 



(The first time you choose the Video for Windows device, it will prompt you to specify the filename
and directory. When you want to open subsequent files, you can go directly to the File menu and 
choose Open.)

To Play a File
From the control panel, choose the Play/Pause button (the first button on the left). To stop 
playing, choose the Stop button (the second button from the left).

To Mark a File
You can play a portion of a video clip by marking the beginning and end of a selection and then 
playing this portion. Set the beginning marker by dragging the slider to the beginning of the 
section you want and choosing the Mark In button on the control panel. Set the ending marker by 
dragging the slider to the end of the section you want and choosing the Mark Out button on the 
control panel. By choosing the Play/Pause button, only the selected section will play.

To Copy a File
Open the Edit menu and choose Copy Object. This will copy the selected video clip to the 
Windows Clipboard. You can now paste the selection to another application or document. Open 
the application or document where you want to paste the video clip. Open the Edit menu in the 
application and choose Paste or Paste Special.

To Quit Media Player
To quit Media Player, open the File menu and choose Exit.

Moving and Sizing Windows
The video display window can be moved and sized on the desktop in the same way as other 
windows. See Microsoft Windows 3.1 User's Guide. Image playback size can also be changed by
pressing <ctrl>+<1>, <ctrl>+<2>, <ctrl>+<3>, or <ctrl>+<4> for 1x, 2x, 3x, and 4x zoom 
respectively.

Video for Windows Sample Clip
A sample video clip is provided so you can try out the Media Player with the multimedia video 
accelerator drivers. This video clip is automatically installed in the WINDOWS directory when you 
install the Windows 3.1 and  video drivers. The filename has the .AVI file extension. 

Performance
As previously mentioned, video is very data-intensive. For this reason, there are a number of 
factors which will negatively impact playback performance. These include:

higher screen resolutions
higher color depths
larger image stretches
larger native image sizes
lower CPU speed
less system RAM
less video adapter memory
data bus architecture differences (e.g. VESA Local Bus vs. ISA)
running multiple videos simultaneously

In addition, the type of video compression used can impact performance. Due to its additional 
color depth, Indeo video is targetted at 486 systems, whereas Video 1 is targetted at 386 or 
higher systems.

Although you may experience some performance degradation depending upon your system 
configuration, be assured that the GRAPHICS ULTRA PRO and GRAPHICS ULTRA+ still offer 



significantly better playback performance than that found on competitive accelerator products, 
allowing you to stretch your video images to a larger, more usable size.

Troubleshooting
Because the typical computer system consists of many different parts, difficulties may arise from 
a combination of items. Refer to your mach32 accelerator user's guide for more information on 
troubleshooting. For the latest version of troubleshooting procedures, refer to the README file on
your Install diskettes.

The video image is not as fast as I'm used to with my television set.

a) Most Video for Windows files are captured at 15 frames per second.  This is half the frame 
rate of television.  Achieving "television like" playback capability currently requires the 
addition of very expensive video hardware.  Video for Windows is intended to be a low-cost, 
mainstream implementation of video.  ATI's role is to make this implementation the best it 
possibly can be without the need to buy additional expensive hardware.  With ATI's mach32-
based accelerators, you can be assured that you are experiencing much better playback 
performance than with any other accelerator product on the market.

My video playback is "chunky" and the audio breaks up when I stretch the image.

a) Several system configuration elements can impact performance.  Please review the 
Performance section for a complete description.  Reducing the stretched size of the image or 
moving to a lower screen resolution may remedy this problem.

b) Verify that the multimedia video drivers are installed by clicking on Drivers in the Control 
Panel.  The VIDEOFX driver should be in the list of installed drivers.  If not, install the 

multimedia video drivers as described in the installation section of this guide.

c) For optimal "larger image" playback, select the Device menu in the media player, then 
Configure, and then select Zoom by 2. If you want, you can save this as the default by 
selecting Set Default. Image playback size can also be changed by pressing <ctrl>+<1>, 
<ctrl>+<2>, <ctrl>+<3>, or <ctrl>+<4> for 1x, 2x, 3x, and 4x zoom respectively.

The video image is moving, but I don't hear any audio.

a) You must have a sound board installed to hear the audio portion of Video for Windows.

b) Refer to your sound board documentation to ensure that the drivers are installed properly.

c) Check the volume settings on your sound board as well as the speaker connections.

d) Ensure that the video clip is not set to MUTE by selecting the menu in the upper left-hand 
corner of the video window.

I don't notice any improvement in multimedia video playback performance with my new 
mach32 accelerator product.

a) The current version of ATI's multimedia video drivers only support acceleration in 16-bit 
(65,000 color) mode and 8-bit (256 color) Palette Manager Off mode (Palette Manager is 
disabled through the FlexDesk Control Panel).  All other modes will result in standard, 

non-  accelerated playback.

4-bit (16 color) mode is generally unacceptable for video playback since video requires a 
more extensive range of colors for a pleasing image.  We recommend 16-bit (65,000 color) 



mode for multimedia video playback.

Subsequent driver revisions may add additional color depth support and/or performance 
increases.  Please monitor CompuServe (GO ATITECH), the ATI BBS or ATI Customer Support 
for future driver enhancements.

If additional questions related to your new ATI product arise, phone ATI Customer Support at 
(416) 756-0711.


